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Overview 

Precision farming tools enable you to make sense of sets of geo -located 

data.  

 

You can create  a coloured image of large sets of data (eg. Yield data) to 

make interpretation of the data easy or you can take a small dataset 

of 15 soil samples and image it just as well. In addition, you can label 

each point with up to 8 individual data value labels. You may want 

use this facility to display the soil test values for eight test items  

 

Many precision agriculture data sources (yield monitoring and spray 

and fertiliser rate controllers) are supported, as well as a generic 

comma delimited format which you c an create in a variety of third 

party programs.  
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FarmStar  - vs - PAM PDP 

The precision farming features of both of these Fairport products are 

the same.  

In PAM PDP (Precision Data Processor) 

¶ There are links between your PAM data and the precision farming  

features. These links will become more powerful as the program 

develops.  

¶ You access the precision farming tools via the Precision Data menu 

option.  

¶ The lists of farms, paddocks, nutrients, consumables and crops are 

used to populate pick lists when using the precision farming tools.  

In FarmStar   

 

¶ You access the precision farming facilities from the File, Show and 

Tools menus.  

¶ You establish the lists of consumables and nutrients as you use 

the program.  

Mapping Terms  

Mapping concepts and jargon can be difficult to understand. With the 

proliferation of GPS units, Google Earth, Google Maps and the like, 

these concepts are becoming more familiar to us. If you would like to 

read a brief description of these concepts, please refer  to page 43 . 

 

Visualizing Your  Data  -  Some Background Information 

If you would like to read a brief description of these concepts, please 

go to page 44 . 
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The PDP Screen Layout 
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Getting your data into PDP  

File Requirements 

The very minimum that a file needs in order to load it into the system 

is two fields describing the geo -location o f each point. That is, either a 

Northing or an Easting, or a Longitude and a Latitude. The visualising 

tools for display can interpret any additional columns of data. All geo -

located data files will contain at least an easting and a northing and 

usually an  altitude.   Specialised files such as yield data files contain 

other data values such as Area, Mass, Moisture, Yield, LoadID and 

more.  

 

If you are generating your own files then we suggest you use a comma 

delimited  format, and ensu re that the first line of the file contains the 

field names of each column.   The program will recognise the field 

names òNorthingó, òEastingó, òNorthó, òEastõ, òLongitude ó, óLatitudeó, 

òLongó, óLató as meaning that the column contains real world 

coordinat es. 

The Data Manager ï ñAll Precision Data Setsò 

Your precision data is imported into PDP and the dataset is registered 

(meaning ð the location of the data is saved to the database and a 

folder is created inside the main folder called òPrecision Dataó (which 

in turn, lives inside your main program folder (PAM or FarmStar).  

You have to let the program know where you r  data is, and what 

format it is in.   

 

From the File menu in FarmStar, choose Precision Data  Processor . 

 

In PAM choose Precision Data Processor  from the Precision Maps 

menu.   

Getting your data from a data card or a folder or removable 

drive 

Yield data and other datasets are often brought in from your harvester 

or tractor on a memory card. These cards, when inserted into the card 

slot on your com puter, behave just like a removable disk. That is, you 
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can access the file(s) on the card through Windows Explorer by 

clicking on the cardõs òDriveó é  

However , PDP can read the data directly from your card . It can also 

read your data from a folder on you r 

computerõs hard disk, or from a 

removable drive (e.g. a USB drive)  

The steps are the same either way:  

Click on the òImport ó button  

Choose the Data Type that you are 

importing . 

 

 

Having chosen the data type, c lick on the Open Card or Folder button.  

Navigate to the folder or card (or removable drive) where you data is 

located. In the screen shot below, I have clicked on the Removable 

Drive (F:)  

 

 

Please Note: For tips on dealing with many of the file types imported 

by PDP, please refer to page 59 . 



P a g e  | 10    Precision Data Processor 

 

Copyright Ò Fairport Technologies 

 

 

 

PDP now display s the contents of the selected location on the right 

hand side of the window... What PDP displays depends on the type of 

data you are importing and the type of on board device that may have 

created the data.  

 You m ay want import all the data or just some of it. PDP has buttons 

to assist you in making your selection . The datasets that PDP will 

attempt to import will be those that have a tick in the òSelectó column. 

In my example above, I have chosen to import 4 datas ets and leave 4. 

Having made your choices, click Next to proceed to the òData 

Matching ó window. 

 

PDP will attempt to match the incoming datasets to your 

paddock list.  The Data Matching windows enables you to associate 

the incoming d atasets with your paddocks. If you choose the ò<Create 

New>ó option on the paddock pick list, PDP will create a new farm and 
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paddock for you (based on the farm and pa ddock name in the 

incoming data  - if they exist) that you may rename later.  

 

When youõre done with Data 

Matching, click the Import 

button to begin the 

importing process.  

 

The screen shown here will 

display the progress of the 

import process.  If you are 

importing a very small data 

set, you may not even get to 

see this progress screen. If 

on th e other hand you are importing a lot of yield data, you will 

definitely see it.  

 

On completion of importing, PDP will display the datasets in the  òAll 

Precision Datasetsó list. 

Tips on Importing Files  

There is a huge range of dat a file types that people need to import. 

Unfortunately some manufacturers often change the file format of 

their files without notifying us. This causes error messages to appear 

in PDP. Please notify us of any file types you are having trouble 

importing and  if possible send us a sample.  

For tips on dealing with many of the file types imported by PDP, 

please refer to page 59 . 

 

If possible it is best to import yield data directly from the card or make 

a complete copy of the card into a folder on your computer (including 

ALL subfolders) and import from there.  

Selecting a Data Set for Analysis 

Clicki ng on the òAll Precision Data 

Setsó button , you will see the list of 

datasets that you have imported , 

organised into a òtreeó and sorted by 

Farm, Paddoc k and Year.   
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. 

If you Right Click on a data set on 

the òtreeó, set you will get an options 

menu.  

You can 

the select 

the data 

set to 

work with  by double clicking on the 

list or by selecting Load Dataset  on 

the menu. It will then bring up a 

window (see below) to allow you to 

select which data field (heading) you 

want to use for your analysis.  

 

 

 

Choose the data column (òZ Valueó) that you want to work within the 

precision Data Desktop. This will be a Yield  column if you are 

importing yield data.  

 

This data will then show as a new item on the  Precision Data 

Desktop  List  
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Precision Data Desktop  

Items in  this list are the data 

sets that youõve chosen from the 

òAll Precision Data Setsó list or 

layers of imag es, contours etc 

which have been generated.  

That is, i t includes Images (that 

have just been created  or those 

re-loaded from the òAll Precision 

Imagesó list) loaded Datasets, 

Range Boundaries (Contours 

just created) and Circles.  

 

Also, i f you have created  or selected a polygon to be used in your data 

processing and analysis, you will also see a layer called òConstraint 

Polygonó on this list. For more information see pages 29 - 31 . 

 

Precision Data Desktop ï Right Click Menu 

If you right click on a n item (a layer of data or an image, or a layer of 

circles or a layer of contours or the Constraint polygon layer)  you will 

get an options menu.  

The number of menu options th at you will see depends on the item 

type youõve selected. All items have the options: 

¶ Visible  - (Hide / Show layer)  

¶ Remove ð (Remove layer from the list)  

¶ Zoom To ð (Make the layer fill the map view window)  

¶ Print  ð to print an image, or the r aw data layer (this 

option will only appear when you have selected a map 

that PDP can print)  
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If youõve selected a 

Data  Set you will see 

the additional 

option s on your 

Right Mouse menu:  

Processing  Over 

Years  and  Generate 

Swath Samples .  

 

Processing  Over 

Years  : This enables 

you to select one or  

more additional 

years to process for 

the purpose of creating a  Maximum, Minimum or Average image.   

See Page 58  for more information.  

Generate Swath Samples: to create a layer of pol ygons that represent 

the path of the machine used when the data was collected. See Page 

21   for more information.  

 

  

  

 

Removing a layer / Hiding a layer 

By Right Mouse clicking on any of the 

layers i n the Precision Data Desktop, 

you can choose òRemoveó to delete that layer from the screen. You 

may want to just hide the layer. In this case, click on the light glo be 

icon to turn off the layer  

 

Zoom to   

To zoom into  the area that the data  occup ies, right click on the data 

layer and choose òZoom Toó from the menu.   
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Working with Data Sets in the Precision Data 
Desktop  

Imaging 

Overview 

Imaging is by far the most powerful function, and there are ma ny 

options available to ensure that you can generate the most accurate 

representation of your data. A good understanding of these options 

will ensure that you donõt make mistakes and potentially misinterpret 

your data.   

 

Image Toolbar 

This is used for proc essing data to create Images  

1.  The òGenerate Imageó button 

2.  The òSave Imageó button ð images can be saved and reviewed 

later via the òAll Precision Imagesó list. Images can also be used 

in some VRT projects (depending on the on board device type)  

3.  Settings. Cl ick this button make changes to the default settings. 

There are image generation settings that can be òtweakedó and 

also naming conventions for saved images.   

4.  Solid (an image with discreet or solid colour areas will be created) 

or Blended (an image with b lended colours will be created) 

Images options.  

5.  Smoothing options. Data can be quite ònoisyó ð you may want to 

smooth out the noise in your data. Try experimenting with these 

button to get a feel for their effect on the images being created.  

6.  PDP has 3 òInterpolationó methods.  ó*ó Fairport Optimised,  

óIó  Inverse Distance,  óKó Kriging . If you are in any doubt 

about which you should use, always choose  ó*ó Fairport 

Optimised  
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7.  The Advance d Image Ana lyzer which can be used to create 

derived i mages from one or more images and by applying 

calculations. For example, you can quickly create a nutrient 

depletion image from a yield image. See page 51 . 

 

To go directly to the steps for creating a Yield Image, go to page 20 . 

 

For a òcrash courseó on the technology behind imaging, please refer to 

page 46 .  

 

For information on using the Advanced Image Analyzer, please refer to 

page 51 . 

 

When you have created an image and you have it selected on the 

Precision Data Desktop list...  

 

 

 

 

... you will notice 2 buttons appear in the data range setting area 

(bottom right of the screen)...  

 

Linear ð vs ð Equalized images  

 

To learn about these opt ions and what they can do for you, please 

refer to page 55 . 

 

Pixel Size 

Pixel size  effects the speed to generate your image, and resolution of 

the image.   It can be adjusted through the òSettings ó 

button on the Image tab . 
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If you increase the pixelõs size up to 10 metres a pixel, you  may get a 

very òblockyó image, however, this also substantially  reduces the 

amount of time required to process the data.  

 

The best advice for pixel size is to experiment. Som etimes, itõs handy 

to choose a fairly large pixel size to generate a quick view of your data.  

As you adjust various parameters, you can reduce the pixel size to 

generate a more finely detailed image.  

 

Naming Conventions for Saved Images 

It is worthwhile becoming familiar with the image naming convention 

settings.  The way you choose to name your images can be adjusted 

by clicking on the òSettingsó button on the Image tab. 

 

On the form that pops up, click on the òNaming Conventionó tab. 

 

Below is an exampl e of how the image name would look if we choose 

every option.  
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Circles 

The Cicles Tab  

 

This is used for processing data to create Circles  

 

1.  The òGenerate Circlesó button 

2.  Optionally choose to display your circles filled with colour  or 

with coloured circumferences only.  

3.  Size Settings. Chose the size of the circles.   

4.  Size your circles based on the values of a chosen data 

column.  

5.  Select the data column to be used to size your circles (this list 

becomes available if you chose to size  your circles by the 

values in a data column).  

 

Circle Colour 

For each circle generated for each point, it is coloured according to the 

original field you cho se. It is coloured according to your clip range and 

palette.  

Circle Size 

For just knowing where your data is, choosing Small circles, and 

choosing the ôFilledõ option is a quick technique. If you want to have 

the circle sizes represent the changing values of another data field, 

choose òSize by selected field valueóé choose the data field from the 

pick list . The larger the data value, the larger the circle size will be.  

 

For more information on visualizing your data using circles, go to page 

27 . 
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Contours 

Contouring Toolbar 

This is used for processing data from the current Image to create 

Management Zones.  

 

1.  The òGenerate Contoursó button 

2.  The òSave Contoursó button ð contours can be saved and 

reviewed later via your farm mapping layers. Contours can 

also be u sed in some VRT projects (depending on the onboard 

device type)  

3.  Transparency slider . Use this to view through the con tour 

polygons to an image below .   

4.  Polygon boundaries can be hidden or displayed.  

 

Note :  The image should hav e minimal colours and detail for this to 

work. If it cannot create the contours try reducing the number of 

colours in the image or make the image smoother.  

Data Set Tools Toolbar 

 

There are three main purposes for the button s on this toolbar.  

1.  To select or draw a polygon to limit the area of a generated 

image (òImage Constraint Polygonó ... See Page 29) 

2.  To sub -set data. Using a selected or drawn polygon, you then 

choose to exclude data from insid e or outside the polygon ð 

then save the remaining data to your Precision Data Set list. 

This can be useful when yield data is collected over more 

than one paddock accidentally.  
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3.  To view data statistics for a selected or drawn polygon . 

 

 

Button to select a polygon from your farm mapping layers  

 

Button to commence drawing a polygon  

 

Button to commence drawing a hole in your drawn polygon  

 

Edit Button ð remove, add or move points o n a polygon 

boundary  

 

Undo Button ð Undo your drawing actions  

 

Panning Tool ð Your mouse cursor becomes a panning or 

dragging tool  to move your image or data display around the 

screen  

 

Selection Tool ð Use this tool if you have finished using your 

polygon and need to delete it. Select polygon, then press Del, 

or right click for the menu  

 

Display Data Statistics  ð click on this button to display a 

spreadsheet of data statistics for the  data inside your drawn 

or selected polygon  

 

Data Subset tool  ð Exclude the data outside the polygon  

 

Data Subset tool ð Exclude the data inside the polygon  

 

Data Subset tool ð Revert back to including the entire data 

set. (Switches off the data exclusion modes)  

 

Data Subset tool ð Save the remaining data to a new data 

set.  

 

For a full explanation of how to use the drawing tools, see page 48 .  
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Creating a ñSwath Polygonò layer 

Most data that is  imported into PDP has been derived from an on 

board device that has logged data from a machine which has a swath 

width. To see the display of the machineõs swath follow these steps:  

 

1.  Select a Dataset on the Precision Data Desktop and then click 

on the òSwath Polygonsó tab to display the options  

 

 

 

2.  Set the appropriate options for the swath layer. The òMergingó 

options are provided due to the fact that sometimes there is a 

vast number of data points in a data set. The òDo not mergeó 

option will result in o ne polygon for each data point. òMerge 

samples by tenó will combine 10 data points into one polygon. 

The òAuto-Mergeó option will result in long polygons where your 

machine has been traveling in a straight line. That is, this 

option will create the least p olygons to represent the job.  

 

3.  GPS Offset ð If the GPS is not mounted centrally on the 

machine, the swath will appear offset. Use  

 

4.  To flood -fill the polygons using the data values of the dataset in 

use, choose that option, otherwise you can choose to lea ve the 

polygons unfilled, or filled with a color of your choosing.   

 

5.  To save the layer of polygons to an ESRI SHP (Shape) file click 

on the Save button. You will need to have the Swatch Polygon 

layer selected in the òtreeó first.  
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Working with Yield Data 

Getting your data from a card 

See Page 6. 

Steps to import your yield data 

Follow the steps outlined for you in t he topic òGetting your data into 

PDPó on Page 8. 

Steps to create a yield image 

When you have a dataset loaded & have c licked on the  Image Tab , 

create an image using the following steps:  

Choose the range of data and colour ing 

that you would like use for the image . 

Data ranges and colours can be saved 

and re -used. Choosing a previously 

saved palette will instantly set up your 

ranges.  In the image at left, I have 

chosen my palette òYield (T/Ha)ó.  

You can click on òAuto-Fit to Data ó and 

PDP will set up the minimum and 

maximum for you to match the data.  

You can manually specify the Min & Max value to trim the data . This 

is to remove zero or false low readings and inaccurate high readings.  

To set the number of colours used in the range  selected , set the  

Number of Intervals  or the Step  value , the coloured circles  displaying 

the raw data (in the centre of the screen) will change automatically.  

 

You can edit the colours  manually by 

clicking in the coloured box in the table . 

The colour chooser will pop up.  

You can save and name these palette 

settings by clicking on the òSaveó button 

at the bottom. These can be re -used at 

anytime by picking from the pick list.  

 

Palettes can also be exchanged with other uses. To exchange saved 

palettes, use the òExportó and òImportó buttons 
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Choose for the type of colour range change. (Solid or  

Blended colour changes ) 

 

Choose for the amount of detail in the ima ge. (Smoother for 

VRT use)  

 

 

Choose the interpolation method .  Leave on Optimised if 

unsure.   See Page 46  for more information.  

 

You are now ready to generate the data image é click the  

òGenerateó button.  

 

 

If you are sa tisfied with the image, click òSaveó and name the 

image for future reference. You may choose to save the image file  

into a special folder that you have made for the purpose. If you let 

PDP manage your images, it will. The òAll Precision Imagesó image 

manager will list all images created and saved using the precision 

farming tools. To display the Image Manager, click on the òAll 

Precision Imagesó button  

 

 

If you want to abandon the image you created  and create 

another with different settings, simply click on the  òGenerateó 

button again   

Imaging Tips and Options  

Unrealistic High Values  

Sometimes your yield data can have some unrealistic, very high 

values  in it. Usually there will be an insignificant number of these 
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unrealistic values and they can be excluded. You are advised to reset 

the range of the data under these circumstances as the image colour 

range can be effected by stray hig h data values. You should also 

exclude any unrealistic low values.  

 

Unrealistic Low Values  

Sometimes it may be difficult to ensure that the harvesting machine 

is always totally in the crop and harvesting a full swath. On such 

occasions the yield monitor m ay record unrealistic low values for an 

area. By excluding these low values, you avoid displaying these 

unrealistic low yielding areas. For example, if you know that the crop 

did not yield below 0.5 Tonnes per Hectare at any point, then use this 

value (or an even higher value) as your minimum.   

 

PDP will display an òXó on the raw data set view of the data where 

you have excluded values. This will indicate to you that you might 

have excluded genuine values. See the screen shot below. I have 

excluded genuin e values from my yield map by setting my minimum 

too low.  

 

 

 Tip: Once you become familiar with the normal range of your 

yield data, it is a good idea to save a òPaletteó for each crop 








































































